# Table of Contents

Definitions/Acronyms/Abbreviations ........................................................................................................... 2  
System Overview ........................................................................................................................................... 2  
  System Requirements and Recommendations ......................................................................................... 2  
Installing iDataFax ..................................................................................................................................... 2  
  Basic Installation ....................................................................................................................................... 2  
DFsend .................................................................................................................................................. 5  
  DFsend Installation .................................................................................................................................. 5  
Logging in to iDataFax ............................................................................................................................. 6  
Preferences .................................................................................................................................................. 9  
Time-out Procedures ................................................................................................................................. 10  
Switching Between Trials ............................................................................................................................ 11  
Logging Out of iDataFax ............................................................................................................................ 11  
Printing from iDataFax ............................................................................................................................. 11  
Saving Data from iDataFax .......................................................................................................................... 13  
View Only Pages ........................................................................................................................................ 14  
Entering Data ............................................................................................................................................... 15  
  Data Status ........................................................................................................................................... 16  
  Color Coding ......................................................................................................................................... 16  
Entering New Data ...................................................................................................................................... 17  
  Randomization ...................................................................................................................................... 17  
  Forms Order .......................................................................................................................................... 17  
  Data Entry ............................................................................................................................................ 17  
  Entering a Reason – Unusual or Missing Data ......................................................................................... 18  
  Entering a Reason – Modifying Existing Data ......................................................................................... 19  
  Missing Values ...................................................................................................................................... 20  
  Partial Dates ......................................................................................................................................... 20  
Using DFsend ........................................................................................................................................... 21  
QC Reports ............................................................................................................................................... 22  
  Checking for Queries .............................................................................................................................. 22  
  Answering Queries ................................................................................................................................. 23  
Using List View ........................................................................................................................................ 24  
  Searching a Field in List View ................................................................................................................ 26  
User Support and Contact Information ................................................................................................. 27
Definitions/Acronyms/Abbreviations

<table>
<thead>
<tr>
<th>Term/Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center</td>
<td>Participating Center</td>
</tr>
<tr>
<td>CRF</td>
<td>Case Report Form</td>
</tr>
<tr>
<td>DMC</td>
<td>Data Management Center (Amherst, USA)</td>
</tr>
<tr>
<td>Patient Binder</td>
<td>Compilation of all available CRFs for a patient</td>
</tr>
<tr>
<td>QC</td>
<td>Quality Control</td>
</tr>
</tbody>
</table>

System Overview

iDataFax is a remote data entry tool that allows Centers to enter their patient trial data electronically. Remote data entry eliminates the need for faxing most CRFs to the IBCSG. This manual explains the procedures for using iDataFax. Use this document and the trial-specific Data Manager’s Manual(s) to complete and submit data.

Patient information in iDataFax is organized in a format very similar to patient packets. This allows Center staff to find and enter patient information in a logical and familiar way. See the Entering Data section for more information about file organization in iDataFax.

System Requirements and Recommendations

- **Internet Connection Speed**: A minimum of a DSL connection is recommended for iDataFax. A slower connection will result in slower response times.

- **Operating System**: iDataFax is available for direct installation on Windows XP, Windows 2000, Mac OS X, Solaris, and Linux.

Installing iDataFax

iDataFax resources (including installation files), support and documentation are available at: [https://www.ibcsgdmc.org/ibcsg/df/](https://www.ibcsgdmc.org/ibcsg/df/)

For trials using iDataFax, they are also available on the IBCSG Member website, on the trial-specific webpage under General Resources/iDataFax Resources.

Basic Installation

1. The executable file may be downloaded:
   a. From the link provided in an e-mail sent by the DMC ([https://www.ibcsgdmc.org/ibcsg/df/](https://www.ibcsgdmc.org/ibcsg/df/)) or
   b. From the trial-specific iDataFax Resources link on the IBCSG Member website.
In either case, clicking on the link will direct you to the iDataFax Resources webpage. Click on the "Downloads" link on the left side. Click on "iDataFax Software". A download window is displayed; click on "Save File".

2. Double click on the downloaded executable. A window will be displayed asking for confirmation to open the executable file. Click "OK".

3. A security warning may appear. If so, click "Run".
4. A Setup Wizard will appear. Click “Next>”.

5. Keep the default Folder for installing the application. **DO NOT CHANGE THIS.** Click “Next >”.

6. Click “Install”.

---

**Note:**
- Do NOT change this.
7. iDataFax will begin installing. A status bar will be displayed.

![iDataFax Installation Screen]

8. When the installation is completed, click ‘Finish’.

![DFsend Installation Screen]

The installation is complete. An iDataFax icon will appear on the desktop.

**DFsend**

DFsend is a simple internet app used to send PDFs (containing scanned data forms, reports and other documents) to the Data Management Center for review and processing. It includes the authentication, encryption, confirmation and tracking needed to meet today’s security and regulatory requirements, and provides a cost-effective alternative to faxing.

**DFsend Installation**

DFsend will need to be installed separately but will follow the same steps as iDataFax installation.

Once the installation is complete, the DFsend icon will appear on the desktop.

Please refer to the “Using DFsend” section for instructions on how to submit PDFs to iDataFax.
Logging in to iDataFax

**Note:** The DMC will provide you with your initial Login Name and Password. You will be prompted to change your password the first time that you log in. Every 90 days, iDataFax will display a prompt to change your password.

If you have lost or forgotten your password, either:

1. Contact datafax.user.support@fstrf.org or
2. Go to [https://www.ibcsgdmc.org/ibcsg/df/](https://www.ibcsgdmc.org/ibcsg/df/) and click on Support/Reset Password

A new password will be sent to you within 2 business days.

1. Double click on the iDataFax icon on the desktop to start iDataFax. The Login box will appear. Verify the “DataFax Server” field displays “idatafax.fstrf.org”. If not, type it in.

2. Enter your Login Name and Password.

If your IT department has installed a proxy server (to filter requests sent to other servers on the internet) click the button to the right of the ‘DataFax Server’ name to register the proxy server. You will need to contact your IT department for the necessary information. The port number used for iDataFax’s secure communication is port 443.
3. The Login box contains a Help button that explains the login:

4. The Help button also has an option which allows you to reset your password. Select Help -> Password Reset. The Reset Password box is displayed. Complete as instructed.
5. Click “Login.” You have officially logged in to iDataFax after you have completed this step and a list of trials to which you have access will be displayed.

6. Double click the appropriate trial or select a trial and click on "OK”.

7. A list of patient icons and a Randomization ID Number for each patient at your Center that is randomized to the selected trial will be displayed.
Preferences

iDataFax has a number of options on how to view and navigate through the data. To view the options, select “File” -> “Preferences” from the menu bar.

This opens up a Preferences window. In the Image Window section, choose “auto open/close” and “split screen”. This will allow iDataFax to display the image of a CRF that was faxed in at the bottom of the screen and the data entered in the database for that CRF at the top of the screen so both are visible at the same time.
Time-out Procedures

To keep patient data secure, iDataFax will automatically log you out after you have been inactive longer than the system setting allows. You can change the length of time before logout. The range of time is one (1) minute to 30 minutes. To change this setting:

1. Select File.
2. Select Preferences.
3. Adjust the time in the “Auto Logout” section.
4. Click “OK.”

If iDataFax is the active application on the screen, any keyboard or mouse activity will reset the 30 minute timer.

When you are automatically logged out, the Auto Logout box will appear. To return to iDataFax, click “Login again.” To exit iDataFax, click “Exit.”

If you are logged out, a dialog box will appear the next time they log in to the same trial. You will be allowed to return to the same page they were on before they were logged out. Click “Yes” in the dialog box to return to the last page. If there were unsaved changes on this page, the dialog box will identify the appropriate Patient ID, assessment number, and page number.
Switching Between Trials

If your Center participates in more than one trial in iDataFax, you may close out of one Trial and open another by doing the following:

1. Save any changes to the current page as final or incomplete.
   
   **Note:** If changes are not saved, iDataFax will display a dialog box prompting you to save any changes.

2. Select “File”.

3. Select “Close Study”.

   This will bring you back to the initial Lists of Trials. You can now open another iDataFax trial by double clicking on that trial.

Logging Out of iDataFax

1. Save any changes to the current page as final or incomplete.
   
   **Note:** If changes are not saved, iDataFax will display a dialog box prompting you to save any changes.

2. Select “File”.

3. Select “Exit”.

Printing from iDataFax

You can print blank forms for each patient to use as a worksheet, or copies of completed forms for reference. A single page or the entire binder can be printed.

1. Open the appropriate patient binder.

2. Select “File”.

3. Select “Print”.

4. Select the appropriate options:

   a. The Page Selection section allows you to determine how much of the patient binder will be printed:

      i. **Blank CRF books:** Allows you to print blank CRFs by patient, visit or page

      Data and images:

          ii. **Current Page:** Prints only the page that is open in the data window.

          iii. **Current Assessment:** Prints all pages in the visit period that is open in the data window.

          iv. **All Open Assessments:** Prints all pages in every open visit period (i.e., all CRFs for that assessment can be seen).

             * Click the □ symbol next to each visit period to open it.

          v. **Current Patient:** Prints all pages in the selected patient binder.
b. The Print Options section allows you to determine what types of images are printed:

i. Blank pages: Prints a blank copy of the selected pages.
   
   Note: The PatID and Month Number/Cycle are completed on every printed page, even if “Blank Pages” is selected. Verify that the correct patient binder is selected before printing.

ii. Completed Pages: Printed pages include the data entered for that patient. The data and primary images can be printed side by side

iii. CRF Images: Prints any faxed images that have been submitted for the patient. You can print a duplicate image by selecting “All images”

c. Color Option

Clicking this box will apply the colors for each field (e.g., blue for outstanding query, red for required/illegal field, etc.)

5. Click “Print”.
Saving Data from iDataFax

You can save blank forms for each patient to use as a worksheet, or copies of completed forms for reference as PDF files. A single page or the entire binder can be saved.

Note: Files saved as PDFs will not be viewable by the DMC. Saved files are to be used for Center reference only.

1. Open the appropriate patient binder.
2. Select “File”.
3. Select “Save as PDF”.

4. Select the appropriate options:
   a. The Page Selection section allows you to determine how much of the patient binder will be saved:
      i. **Blank CRF books**: Allows you to save blank CRFs by patient, visit or page
         Data and images:
      ii. **Current Page**: Saves only the page that is open in the data window.
      iii. **Current Assessment**: Saves all pages in the visit period that is open in the data window.
      iv. **All Open Assessments**: Saves all pages in every open visit period (i.e., all CRFs for that assessment can be seen).
         - Click the symbol next to each visit period to open it.
      v. **Current Patient**: Saves all pages in the selected patient binder.
   b. The Save Options section allows you to determine what types of images are saved:
      i. **Blank pages**: Saves a blank copy of the selected pages.
Note: The PatID and Month Number/Cycle are completed on every saved page, even if "Blank Pages" is selected. Verify that the correct patient binder is selected before saving.

ii. Completed Pages: Saves pages include the data entered for that patient. The data and primary images can be saved side by side

iii. CRF Images: Saves any faxed images that have been submitted for the patient. You can save a duplicate image by selecting "All images"

c. The PDF File Selection section allows you to assign the name and location of the saved file.
d. Click “Apply Field Color for Completed Pages” to display the color coded status information for each field.

5. Click “Save”.

View Only Pages

Pages marked “view only permission” at the bottom of the screen are pages that the Center cannot make changes to.
Entering Data

iDataFax is organized chronologically, similar to the Patient Packets that the Centers currently use. When you select a study in iDataFax, you will see a list of patient icons (head icons). Each head icon has a Randomization ID Number corresponding to patient at your Center next to it. Double clicking on the patient icon will open the patient binder. Inside the binder is a list of all forms for the trial, ordered by visit (e.g., Baseline, 3-Month/Cycle, 6-Month/Cycle, etc.).

**Note:** All forms for the trial will appear in the patient binder. Certain forms may not be required for every patient. For example, a Radiotherapy (R) Form may be in the binder for all patients. If a patient is not going to receive radiotherapy, do not complete the Radiotherapy (R) Form.
Data Status

iDataFax will display icons next to each patient and CRF that will indicate the current status of that item. These icons show you which patients or CRFs need additional information.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Empty head" /></td>
<td>Empty head – a new binder, not yet started.</td>
</tr>
<tr>
<td><img src="image" alt="Green head, green checkmark" /></td>
<td>Green head, green checkmark - The patient has been randomized and the binder is available. Opening the patient binder will show all CRFs. A green check next to the patient’s head indicates no problems with the data.</td>
</tr>
<tr>
<td><img src="image" alt="Red head, red “x”" /></td>
<td>Red head, red “x” - The patient has been randomized and the binder is available. A red X indicates one or more records have inconsistencies that need to be addressed. Opening the patient binder will show all CRFs. The ones with red X’s need to be reviewed.</td>
</tr>
<tr>
<td><img src="image" alt="“L” head" /></td>
<td>“L” head – all records completed to date have been marked as lost (e.g., unavailable).</td>
</tr>
<tr>
<td><img src="image" alt="Green check, square" /></td>
<td>Green check, square - This record/assessment has no outstanding queries, missing required fields, or other discrepancies. The square denotes it is a required assessment or page. <strong>NOTE:</strong> Square and check will be red if this record/assessment has outstanding queries, missing required fields, or other discrepancies.</td>
</tr>
<tr>
<td><img src="image" alt="Green check, circle" /></td>
<td>Green check, circle - This record/assessment has no outstanding queries, missing required fields, or other discrepancies. The circle denotes it is an optional assessment or page and may not be required for all patients. For example, page 2 of the CCM Form is in the patient binder, but is completed only conditionally upon an answer on Page 1. <strong>NOTE:</strong> Circle and check will be red if this record/assessment has outstanding queries, missing required fields, or other discrepancies.</td>
</tr>
<tr>
<td><img src="image" alt="Green check, diamond" /></td>
<td>Green check, diamond – This record/assessment is an unexpected assessment or page (e.g., RC Forms completed for a non-required visit). These forms are not in the patient binder and will be faxed into the system. <strong>NOTE:</strong> Diamond and check will be red if this record/assessment has outstanding queries, missing required fields, or other discrepancies.</td>
</tr>
</tbody>
</table>

Color Coding

iDataFax uses different colors to provide information about each field. The chart below explains each color that appears in iDataFax.

<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>White/Black</td>
<td>Legal value</td>
</tr>
<tr>
<td>Red</td>
<td>Illegal value or blank required field</td>
</tr>
<tr>
<td>Yellow</td>
<td>Blank optional field</td>
</tr>
<tr>
<td>Blue</td>
<td>Unresolved query or a rejected reason</td>
</tr>
<tr>
<td>Orange</td>
<td>Query or reason has been answered by Center, but DMC has not yet reviewed</td>
</tr>
<tr>
<td>Green</td>
<td>A resolved query, an accepted reason, or a predefined missing value code</td>
</tr>
</tbody>
</table>
Entering New Data

Randomization

Within 24 hours of patient randomization via the IBCSG Registration/Randomization system, the patient binder will appear in iDataFax.

Forms Order

When a patient is randomized, all forms for the life of the trial are available in the patient binder. Some forms may not pertain to a specific patient’s treatment and therefore, do not need to be completed. Do not enter or save changes on CRFs that are in visit periods that have not yet occurred. If CRFs are submitted out of the appropriate sequence of visits, queries will be generated.

Example: A patient is scheduled to come in for the six (6) Month Follow-up visit. If data is submitted for the 18-Month Follow-up instead, the QC report will request all of the data from the time between the 6-Month and 18-Month Follow-up visits.

Data Entry

1. Double click the appropriate patient icon to open the file.

2. Click the symbol next to the appropriate visit. The visit will expand and all forms available for that visit will be displayed.

3. Click on the appropriate form. The form will open in the data window.

4. Enter information for each appropriate field.
   a. Each form may be navigated by either using the mouse or using the Tab key to tab through the fields. It is recommended to tab through each field so that any warnings can pop up to remind you to enter data or to let you know something has been entered incorrectly.
   b. It is recommended you answer all questions in order. Answer all appropriate questions before submitting the CRF.
5. If the information entered is not logically correct, or conflicts with other information, a warning message may appear. This dialog box will explain the inconsistency and prompt you to correct the problem. You can decrease the number of queries on the QC Report if you correct the data before it is submitted.

   a. If you do not correct the inconsistency, the page can still be saved. The inconsistency will be brought to the Center’s attention again once the DMC has reviewed the page and added a query.

6. Save the page when all necessary questions are answered.

   a. You must save each page after data entry is complete. When the record is saved it is automatically sent to the DMC for review. There are two (2) different save modes:

      i. **Final**: Save the record as Final when there are no outstanding fields, queries, or inconsistencies on the page. If there are outstanding problems on the record, the “Final” box will be gray and you will not be able to click it. Records saved as Final will appear in the patient binder with a green check mark.

      ii. **Incomplete**: Save as Incomplete when there are outstanding data, queries, or inconsistencies that still must be resolved. Records saved as Incomplete will appear in the patient binder with a red X.

      **Note**: Records saved as Incomplete will be submitted to the DMC with the inconsistencies. The Center may return to the record and add additional information at anytime. If changes are saved, the amended form will be sent to the DMC. See the Correcting Data section for more information.

      **Note**: The Pending option appears on the Save Bar, but cannot be used.

**Entering a Reason – Unusual or Missing Data**

When completing a CRF, you may provide an explanation for unusual or missing data (e.g., question was not asked, procedure done at another institution, lab values abnormal due to chemotherapy, etc.) by using the Reason for Data Value Box. This additional information may eliminate the need for a query.
1. Click on the field for which a reason is being provided.

2. Click the button in the Reason box title bar. This will launch a text box.

3. Type the reason in the text box.

4. Click OK to save the reason. The field will turn orange, indicating that a reason has been entered and must be reviewed by the DMC. If the DMC approves the information in the Reason box, the field will turn green. If the DMC has additional questions, a query will be issued, and the field will turn blue.

5. Save the record before navigating off the current plate.

**Entering a Reason – Modifying Existing Data**

If a record has been submitted to the DMC but there is incorrect data on the page, the Center can correct the information. This feature allows the Center to ensure that the data provided is correct and may also eliminate the need for a query. When a field is changed on a saved record, you will always have to enter a reason for making a change.

The Center may also enter a reason on a field to clarify a value that may be questioned by the DMC (e.g., out of the legal range, such as weight). Doing this before submitting the data may prevent a query.

1. Open the correct form in the Data Window.

2. Change the appropriate field.

3. Move to the next appropriate field or save the record.
   a. When you click away from the field that was changed a Reason box will appear. Enter the reason for changing the value.

   ![Reason for Data Value Window](image)

   b. Click OK. Clicking “Revert to Old” will change the value back to what it was before the current you changed it and leave the Reason for Data Value box open.

   c. Clicking “Cancel” will cancel the change and close the Reason for Data Value box.
4. The field will turn orange. Once the DMC has reviewed and approved the reason, the field will turn green.

5. Save the record before navigating off the current plate.

**Missing Values**

In DataFax, when a value is unknown, not done or unobtainable, Centers are instructed to write -1 on the CRF so the DMC knows not to ask for this information. When entering data in iDataFax, -1 is not an acceptable answer. When a value like this needs to be noted, the Center must use the Missing Value function. This can be done in two ways:

**Option 1**

1. Click on the field in question.
2. In the toolbar at the top of the screen, click on “Field” tab.
3. In the drop down menu, Click “Mark Field Missing ► not available”. This will change the field to green.

**Option 2**

1. Click on the field in question.
2. Click on the button in the Missing Value box.
3. Select “not available”. This will change the field in question.

If at any time you wish to enter data in these fields you will need to follow the steps above and then select “No Code (reset)” to change the field back to its original color and enter data.

**Partial Dates**

Partial dates are considered illegal (red field) by iDataFax. However, if the date is viewed as valid by the DMC, it will be accepted and the field will be changed to green.
If the month and year are known but the day is unknown, 00 can be entered for the day. For example, if the date is May 2011, 00/05/2011 should be entered in iDataFax.

If only the year is known and the day and month are unknown, 00 should be entered for both the day and month. For example, if the date is 2011, 00/00/2011 should be entered in iDataFax.

If the entire date is unknown, the field should be marked as Missing Value/Not available. Do not enter an unknown date as 00/00/0000.

**Using DFsend**

Some types of data cannot be submitted through iDataFax:

- Quality of Life: Quality of Life Forms that are completed by the patient cannot be entered in iDataFax.
- Reports: Pathology and Autopsy Reports cannot be data entered at the Center.
- SAE Queries: SAE Queries are sent by e-mail from the Safety Office. They must be completed by hand.

Forms that cannot be submitted through iDataFax should be either faxed into DataFax using the standard DataFax procedures or submitted using DFsend. Once received and entered by the DMC, these forms/reports will be viewable, but not editable, in iDataFax.

**Note:** If using DFsend, the information must be in PDF format.

To use DFsend:

1. Login by entering your username and password
2. Document selection – Drag and drop one or more PDFs onto the DFsend application or click the Add button to use the standard file selection dialog.
Note: All pages must have the patient’s Randomization ID Number and Center Code written clearly on them or we will be unable to identify the pages and they will not be routed to the patient’s file.

3. Transmit - Click the Transmit button to send the selected PDFs to the study server.

4. Confirmation - Watch the progress bar as each PDF is transmitted. On completion, DFsend displays the transmission status of each PDF file.

5. Study server - If the PDF contains study CRFs, they are read by ICR software to create a new data record. Data management staff review each PDF received and any ICR results. PDF pages are linked to data records and saved to the study database.

6. Tracking - Each PDF transmission is logged by: username, date, time and transmission status. This information is readily available when viewing pages in the iDataFax electronic patient binders. Past transmissions can be reviewed in the DFsend application.

QC Reports

QC Reports will be distributed to all Centers via e-mail. The benefit of iDataFax is that Centers can view all queries at any time and have a chance to answer them before the next QC Report is generated. Centers can either answer the QC Report queries on paper and fax in the responses or answer the queries immediately in iDataFax.

Note: You do not need to do both.

Checking for queries and answering them before the QC Report is generated will reduce the number of QCs on the report. See Checking for Queries and Answering Queries for more information.

Checking for Queries

iDataFax can create a list of all outstanding queries for a Center. If these queries are found and corrected prior to the distribution of the QC Report, the Center can decrease the size of the QC Report.

1. Select the “View” drop down menu on the tool bar.

2. Select Queries.

3. A list of all queries for all your Center’s patients on the trial will be displayed. Queries with a green check have been resolved and require no further action. Queries with a red X require a reply from you.

4. You can specify which queries are displayed (all queries, only outstanding ones, etc.).
   a. Select the “Show” drop down menu on the tool bar.
   b. Select the desired option.
5. Double clicking a query will open the patient binder to the CRF page that has the query. The query can be answered at this point.

6. To return back to Query View, click on the “Return to Query View” bar located below the patient binder.

7. When you are done with Query View, you can return to the patient binder by selecting “View” from the tool bar and then click on “Data”.

**Answering Queries**

Fields that have queries associated with them are highlighted blue.

1. Click on the field being queried.

2. The query will be displayed in the Query box on the left side of the window.

3. Click the button in the Query box title bar. This will launch a text box.

4. Type the query response in the text box.

5. Click “Save.”
6. The field will turn orange. When the DMC reviews and resolves the query, the field will turn green. If further clarification is needed, the DMC will write a new query which will, in turn, change the field back to blue and require another response from the Center.

Using List View

List View allows you to view all data records for a selected CRF page in spreadsheet form. Each row in the spreadsheet is a data record and each column is a data field. This data can be searched and sorted.

To access List View from the toolbar at the top, select “View” and then “List”. This will open up a window showing all CRF pages available for that trial.

When one page is selected, a table will replace the data window. The table will list each variable contained on the plate and the data entered in iDataFax for each patient.
**Note:** No data can be changed in List View. “View Mode” will appear at the bottom of the screen to remind the DM of this.

Any column can be reordered in ascending or descending order by clicking on the Variable Name in the top row. Double clicking on any field in the table will take you back to Data View where the page/data can be seen and amended.

The fields can also be color coded to match the date (blue for fields with queries, green for resolved field, etc). To activate this option, choose “File” from the tool bar and “Preferences” from the drop-down menu. Under “List View” click on “show field color coding” and then click “OK”.

All fields on that plate will be displayed in a line; one line per patient. To reduce the number of fields seen, click “Select” from the toolbar and then “Field Selection”. A pop up box with all the fields will be brought up.

Click on “Deselect all fields” and then individually select the fields you want to review. Then click “Apply”. The screen will then only show the fields you selected.
Searching a Field in List View

The Search function in List View can be used to find records with a specific data value or attribute.

While in List View select the plate you would like to search.

Choose “Search Field” in the “Select” menu.

Click on the “…” button next to the Field # box, and choose the field you would like to search.

Specify the data you are searching for, check the “Filter” box and click “Find”. The data that matches the search criteria will appear in spreadsheet form on the right side of the screen.

The example below is a search on the Surgery Form. It is looking for all occurrences of mastectomy (Surgery type = “9-mastectomy”) reported in question 2 (fields 15, 18, 21, 24 and 27) on all Surgery Forms.
The records you selected will appear in the window. If there is a fax image it will appear below the list.

To view the entire patient file, you can either double click on the line in List View or select “Switch to Data View” below the forms listing to the right. Once in Data View, you can return to List View by selecting “Switch to List View” below the patient binder.

This function can also be used to search queries and reasons. The “Search Fields” box can be used to further narrow results by site, patient ID, assessment, level date of creation and date of modification.

**User Support and Contact Information**

For questions related to trial-specific issues, contact the DMC at the appropriate e-mail address.

iDataFax resources, support and documentation are available at: [https://www.ibcsgdmc.org/ibcsg/df/](https://www.ibcsgdmc.org/ibcsg/df/)

For technical questions about iDataFax or connection issues, contact DMC user support at [datafax.user.support@fstrf.org](mailto:datafax.user.support@fstrf.org).